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Chapter 1  

Introduction 

This document contains important hint and tips for developers that use the Poll 
Module. In it you will learn how to properly install the module, and also get to know 
important features of it.  

This manual contains the following chapters: 

 Chapter 1, Introduction 
The first chapter is a brief introduction to this manual. 

 Chapter 2, Installation 

The second chapter covers useful installation aspects. 

 Chapter 3, Using Polls 
The third chapter delivers a brief overview of the Poll module’s functionality and its 
features. 

 Chapter 4, Developer Hints 

The fourth chapter provides more ’insider’ information about the Poll Module for 
developers and system architects. 
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Chapter 2  

Installation Guide 

The Poll Module is distributed as a standard Sitecore package. In order to start using 
it, you should install the package via the Sitecore desktop link Sitecore » 
Development Tools » Installation Wizard. The following sections describe the 

installation process in detail.  

The Sitecore Poll Module is designed for Sitecore CMS starting from version 6.0.0 
and higher. It can be installed both on Sitecore Starter Kit and on a clean Sitecore 
solution. 

Note 

For the module to work, it is not required to restart the Sitecore client after the installation. 
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2.1 Installing Poll Module 

The Poll Module is installed with the Sitecore Installation Wizard available via the Sitecore desktop 
link Sitecore » Development Tools » Installation Wizard. The following sections will guide you through 

the package installation process. 

2.1.1 Upload the Package 

 Select the Upload button to open the Upload Wizard. 

 Select the Browse button on the Select Files step and locate the Poll package on your local 
machine. 

 Select the Open button on the Choose File dialog when you have selected the Poll package. 

 Select the “Next »” button on the Select Files step. 

 Select the “Next »” button again, on the Overwrite Existing Files step. 

 Select the “Finish” button to close the Upload Wizard. 

2.1.2 Install the Package 

 Select the “Next »” button on the Specify Package step. 

 Read the Shared Source License and select the “I accept the terms of the license agreement” 
radio button. 

 Select the “Next »” button on the License Agreement step. 

 Read the Readme information. 

 Select the “Next »” button on the Readme step. 
The Installation Wizard now displays the Ready to Install step, which shows the revision of 

the Poll package you will install. 

 Select the “Install” button to begin the installation. 

Choose “Overwrite All” for files when prompted. 

It is not required to restart the Sitecore client after the installation for the module to work. 

2.1.3 Templates, Controls, Accounts and Features Available after 
Installation 

The Poll module package installation adds a number of templates and controls to your Sitecore 
solution.  

The following templates are installed in the /Templates/Poll Module folder: 

 Poll – the template used to create poll Items. 

 Poll option - the template used to create items that contain poll options. 

 Poll archive - the template used to store older polls. 

 Branches/Create new Poll - a branch template that is used to run a wizard that creates a 

new poll. 
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You can see these templates in the following image: 

 

The following web controls are installed:  

 Poll Wizard- a wizard that helps to create a poll 

 Poll Info – a viewer for poll items 

 Poll Voting Sublayout- a sublayout to render backend pages 

Apart from that, installation adds a new account to the Sitecore Security - sitecore/poll. This account is 
used for communicating with the Sitecore web service. You must not delete it, disable or change its 
password. This account can access only the required poll items. The account access rights must not 
be changed, either. 

If you are using servers with staging scenario implemented, you must change the reference to the 
server which contains the master database. This setting is stored in the 

/App_Config/Include/PollConfig.config file, in the "Poll.StagingMasterUrl" setting.  
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Chapter 3  

Using Poll Module 

This chapter describes how to configure and use the Poll module.  

The chapter includes the following sections: 

 Creating a New Poll 

 Managing Existing Polls 

 Archiving Polls 

3.1 Creating a New Poll 

Polls can be created in two different ways:  

1. Using the Page Editor - the Page Editor enables you to place a poll on a certain spot on a 

page and to manage it. Recommended for users with basic knowledge of Sitecore.  

2. Using the Content Editor – the Content Editor provides all poll creation and management 

options, such as closing the poll, etc. 

3.1.1 Creating a New Poll Using Page Editor 

Follow the next steps to create a poll using the Page Editor. 

1. Log in to your web site in the Page Editor mode. 

2. Navigate to page where a poll needs to be placed.  

3. Click the Edit button and then click the Ribbon button to make the ribbon visible. 
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4. Select the Presentation tab. The Insert button is available in the Poll chunk. 

 

5. Click the Insert button to launch the Poll Wizard.  

3.1.2 Poll Wizard 

The Poll Wizard simplifies the process of creating a poll and filling its properties. It contains the 
following steps. 

1. Specify the poll question. 

 
The Poll name field defines the Item name in the Content Tree.  
The Poll intro text (the question of the poll) is shown above the poll options. This field can 

contain HTML tags.  
The Thank you text appears after a site visitor places his or her vote. This field can also 
contain HTML tags.  
Click the Next button when finished. 
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2. Add poll options. 

 
Note: even if you leave out the middle option, the rest of the options will appear on the site.  

Click Next to continue. 

3. Choose the placeholder for the poll. 
Move the pointer over a placeholder in this window to see where exactly the poll will be 
placed. 

 
Click Next to finish the poll creation. 
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See how it looks on the front-end: 

 

3.1.3 Creating a New Poll Using the Content Editor 

Creating a poll using the Content Editor gives you the following advantages over the Page Editor: 

 Polls can be stored not only on a page, but in any item or a folder.  

 You can manage all poll properties (for instance, edit the Thank you text, uncheck the “One 
vote per user” checkbox).  
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To create a poll using the Content Editor perform the following actions: 

1. Select in the Content Tree the Item which will store a new poll.  

2. Navigate to the Home tab and click the Insert control.  

 

3. Add the poll branch to the selected Items and confirm your choice. 
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4. Clicking the Poll branch in the Insert list runs the Poll Wizard.  

 

For detailed information on the Wizard see Section 3.1.2, Poll Wizard. This time the Wizard 

will, however, not display Step 3 (choosing a placeholder).  

5. The newly added poll will be displayed along with other subitems under the, selected on first 
step, item.  
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6. In the next step define the placeholder and the rendering for the poll. Choose the “Poll Voting 
Sublayout” as a rendering. Add the PollPath attribute to rendering. The value to enter has to 
be the path to the added poll. 

 

The poll is now ready for use and can be previewed using the Preview functionality of the Publish 

tab.  

3.2 Managing Existing Polls 

Polls can be managed in two different ways:  

1. Using the Page Editor – the Page Editor enables you to place a poll on a certain spot on a 
page and to manage it. Recommended for users with basic knowledge of Sitecore.  

2. Using the Content Editor – the Content Editor provides all poll creation and management 

options, such as closing the poll, etc. 

3.2.1 Managing a Poll Using the Page Editor 

1. To be able to edit a poll on a certain Web site page log in to your Web site in the Page Editor 
mode. 

2. Go to the Web page with poll question and place the pointer over the element that you want 
to edit.  

 

3. Note that you can edit any visible text of the poll directly on the site. For edit poll question you 
can use the Text Editor buttons on the screenshot above to perform the following operations 
on the text: 

a. Edit the text 

b. Make the text bold 

c. Make the text italicized 

d. Underline text 
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e. Insert a hyperlink within the text 

f. Insert a picture 

g. Go to the Content Editor for more editing options 

Do not forget to save the changes. The page will reload automatically to apply the changes.  

3.2.2 Managing a Poll Using the Content Editor 

While managing a poll item among other things you can do the following: 

 Add, rename, edit, delete and sort poll options 

 View poll results 

 Reset poll results 

 Close and unclose the poll 

 Start a sub-poll  

 Allow site visitors to vote multiple times 

 Define security preferences 

These options will be described below in more detail.  

Adding, Renaming, Editing, Deleting and Sorting Poll Options 

You can add a poll option in two ways: 

1. Insert a poll option by right-clicking on a poll item and using the Insert menu: 

 



Poll Module Administrator Guide  

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2008 Sitecore. All rights reserved.  

Page 15 of 24 

2. Insert a poll option using the Insert chunk on the Home tab:  

 

To rename a poll option right-click the required option item and click Rename.  

 

To edit a poll option, just select it in the Content Editor. 

To delete a poll option right-click the option in question and select Delete.  
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To sort poll options use the sorting controls from the item menu. 

 

Viewing Poll Results 

To view the poll results click the required poll in the Content Tree. The poll results will be displayed in 
the Poll tab on the right.  
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To view the number of votes for each single poll option, click this option. The results are stored in the 
Votes field section.  

 

Resetting Poll Results 

Poll voting results can be reset to the initial state. To reset poll results select the required poll item and 
click the Reset button in the Poll operations chunk. The number of votes for each separate poll 
option is reset to 0. 

 

Note that you can perform Reset operation only on Polls which contain some votes. For Polls without 
votes this button is inactive.  

Closing and Unclosing Polls 

Closing a poll in the Content Editor not only closes the poll for voting, but also hides the Poll on the 
web site. However, you can also unclose the poll; and the poll will become visible on the site again.  
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To close the poll, click the respective button in the Poll Operations chunk.  

 

Note that In the Settings field section the Closed checkbox is now checked.  

 

To make the poll visible again unclose the poll by unchecking the Closed checkbox.  

Starting a Sub-Poll 

Sub-polls are created when you want to arrange a poll with poll options and a question different from 
an existing poll, but you want the new poll to use the same item in the content tree so that you don’t 
have to edit the renderings. At the same time, the results of the previous poll are preserved in an 
archive. 
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To create a sub-poll, select an existing poll and click the Start new button in the Poll Operations 

chunk. 

 

Notice that the Poll name field in the Wizard dialog is grayed out because the sub poll you create will 
use the same item as the previous one. 

A newly created sub-poll is placed on top of the previous poll into the same item. The older poll will be 
put in the Archive folder as shown below.  
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Allowing/Forbidding a Site Visitor to Vote Multiple Times 

This option is controlled by the One vote per user setting: 

 

If the One vote per user checkbox is selected, a site visitor can only vote once in a particular 

browser. After a site visitor has voted, a cookie ID corresponding to the current poll is created. As a 
result the site visitor who voted will not see the poll form any more. He or she will only see the vote 
results. 

 

Note 
In fact a site visitor can vote multiple times even if the checkbox is selected. To do this he or she has 
to delete the cookies of the browser involved.  

If the One vote per user checkbox is not checked, a site visitor will be able to vote multiple times 

from one and same browser, just by refreshing page 

Defining security preferences 

You can restrict access to the poll items like to any other Sitecore items. 
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3.3 Archiving Polls 

Polls are archived automatically when a sub-poll is created with the Start New Poll command. See 
Section Starting a Sub-Poll for more details.  

In the Archive you can view previous polls and their results.  

An archived poll’s name also includes the date when the poll was archived.  
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Chapter 4  

Developer Hints 

This chapter provides module architecture information for developers.  

4.1 Module Architecture 

The current version of the Poll Module supports only one type of multiple choice questions - one from 
many. Voting is based on AJAX technologies so that only the poll item will be reloaded and not the 
whole page.  

The Module supports staging scenarios. A poll module placed on a remote Web server can 
communicate with master database using the standard Sitecore WebService. 

A poll module item has a nested structure of several levels.  

If a poll item does not contain an archive it consists of two levels: 

 Poll item. 

 Poll options 

 

If a poll item includes earlier archived polls in the Archive folder it contains the following levels: 
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 Poll item 

 Poll options and Archive folder 

 Archive’s poll item or items 

 Archive’s poll item’s options 

 

Warning 
While adding a poll, make sure not use a rendering that would automatically take all subitems of an 
item for its output. A good practice example is a rendering which differentiates between different types 
of templates, for example the menu entry templates and the rest. Otherwise, you will not be able to 
insert polls normally at all. 

4.1.1 Poll Item 

The poll item is based on the poll item template.  

 

The template has the following sections and fields: 

 The Data section contains the Intro and Thank you fields. 

 The Button titles section contains title for  Place vote button  
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 The section Settings contains a checkbox that indicates whether a poll is closed or not. The 
Close command in the contextual ribbon changes the state of this checkbox. Also this section 
contains the One vote per user checkbox. 

The contextual ribbon of this Template allows performing such operations as create new, reset and 
close poll.   

 Start new command creates a new poll. 

 Close command prevents the poll control from rendering on the Web site. 

 Reset nulls the votes count. 

The Editor application of this Template displays current voting results, and indicates whether a poll is 
closed or archived. 

 

4.1.2 Poll Item Options 

Poll options are based on the poll option template.  

 

Title is a mandatory field of the Data section, because it is used by client controls.  Also a poll option 
item has the VotesCount field which contains a number of votes cast for this item. 

4.1.3 Archived Poll Item  

An archived poll item is based on the Poll archive template. 

 


